
Main Interface



What is PeepNet?

PeepNet is an IP analyses tool. It will load files with captured IP packets and will try to put those
packets together in the correct order to show you what they are hiding.
PeepNet knows to interpret trace files created with ALL other sniffers as long as they contain 
raw data.

"What this means is that you no longer have to pore over long logs of barely readable hex codes. This 
program RECONSTRUCTS the actual sessions. This brings sniffers and sniffing technology to an 
entirely new level. If sniffing was an arcane art known only to "Bastard Operators from Hell" - a popular 
smart Sys Admin pseudonym - and hackers, well, now their job is far easier, but their secrets are now out 
in the open."
Comment taken from Drew’s web site.



Choosing TCP/UDP ports

Click here to select TCP/UDP ports. Only TCP or UDP packets with source or destination port in
this list will be taken in consideration. All other packets will be discarded. The main season for 
this filter is for selecting specific services. An empty list means ALL ports.

Example: Selecting port 25 will instruct PeepNet to show only emails.



If you find annoying the progress bars, which show up when loading a capture file, disable them 
from here.



When unchecked, only TCP connections will be displayed. If you want to see also the UDP 
connections, check this.



General files settings 

General settings concerning various files used by PeepNet.



Use DNS

When this check box is checked, PeepNet will use DNS reverse lookup to find out the name of 
the client hosts. Names found will be saved when program exits, in DNS file hosts.txt.



View DNS file

View or edit the DNS file hosts.txt. User can edit this file.
 Lines starting with # will be ignored.

Commentary example:
#This is an ignored line.

Valid entry example:
193.231.21.56                student.mta.ro



Selecting hosts

Include or exclude hosts (by their IP address) from monitoring.



Logging

This is an important setting. Having this check box checked, all capture files analyses are 
directed to the log file instead of display. This option is useful when CaptureNet and PeepNet are
running continuously monitoring a network segment.



Log file

In this log file is stored data about identified TCP/UDP connections when Logging check box is 
checked,



Run

Run means that PeepNet becomes active looking for new data if available from CaptureNet. 
When new data arrives (indicated by a progress bar), PeepNet will automatically analyze the new
data and depending on the check state of the Logging check box, will write the results to the log 
file or onto the screen.



View log

Will launch the Notepad program to show the log file content.



Progress Bar

When Run is selected this progress bar will indicate the filling rate of the CaptureNet’s packet 
buffer. When this buffer is full, PeepNet will automatically analyze packets found in this buffer. 
For this progress bar to function, the Announce progress control from CaptureNet’s 
Miscellaneous panel must be checked



Back to the previous web page

Same meaning as the Back button of a web browser



Forward 

Same meaning as the Forward button of a web browser



Stop loading current page

Well, it really does this



Connection number and type

 icon    indicates HTML pages.
 icon    indicates an unknown connection type.
 icon    indicates emails (SMTP sessions).
 icon    indicates POP3 logins.
 icon    indicates Telnet sessions.
 icon    indicates web pages with a non HTML content – probably images



Logged connections

How many connections has been identified and written in the log file. Active only in Logging 
mode



File menu commands

The File menu offers the following commands:

New 
session

Deletes all temporary files.

Open Opens an existing document.
Exit Exits PeepNet.



Help menu commands

The Help menu offers the following commands, which provide you assistance with this 
application: 

Help 
Topics

Offers you an index to topics on which you can get help.

About Displays the version number of this application.



New session command (File menu)
All entries displayed in the left view will be removed and all temporary files will be deleted. Sets
internal counters to zero.

You can open an existing capture file with the Open command.

Shortcuts
Toolbar:

Keys: CTRL+N



Open command (File menu)

Use this command to open an existing capture file 

Shortcuts

Toolbar:
Keys: CTRL+O



File Open dialog box

The following options allow you to specify which file to open:
File Name

Type or select the filename you want to open.    This box lists files with the extension you 
select in the List Files of Type box. 

List Files of Type
Select the type of file you want to open:
PeepNet capture files
All files (*.*) for ALL raw data log files containing IP datagrams

Drives
Select the drive in which PeepNet stores the file that you want to open. 

Directories
Select the directory in which PeepNet stores the file that you want to open.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



1, 2, 3, 4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last four 
documents you closed.    Choose the number that corresponds with the document you want to 
open.



Exit command (File menu)

Use this command to end your PeepNet session.    You can also use the Close command on the 
application Control menu.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the most 
common commands in PeepNet, such as File Open.    A check mark appears next to the menu 
item when the Toolbar is displayed.

See Toolbar for help on using the toolbar.



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    The 
toolbar provides quick mouse access to many tools used in PeepNet,

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Click To
Open a new document.

Open an existing document.    PeepNet displays the Open dialog box, in which you can 
locate and open the desired file.



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be executed 
by the selected menu item or depressed toolbar button, and keyboard latch state. A check mark 
appears next to the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.



Status Bar

The status bar is displayed at the bottom of the PeepNet window.    To display or hide the status 
bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to 
navigate through menus.    This area similarly shows messages that describe the actions of toolbar
buttons as you depress them, before releasing them.    If after viewing the description of the 
toolbar button command you wish not to execute the command, then release the mouse button 
while the pointer is off the toolbar button.

The right areas of the status bar indicate which of the following keys are latched down:



Using Help command (Help menu)

Use this command for instructions about using Help.



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of PeepNet.



Context Help command 

Use the Context Help command to obtain help on some portion of PeepNet.    When you choose 
the Toolbar's Context Help button, the mouse pointer will change to an arrow and question mark. 
Then click somewhere in the PeepNet window, such as another Toolbar button.    The Help topic 
will be shown for the item you clicked.

Shortcut
Keys: SHIFT+F1



Title Bar

The title bar is located along the top of a window.    It contains the name of the application and 
document.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging their
title bars.

A title bar may contain the following elements:
Application Control-menu button
Document Control-menu button
Maximize button
Minimize button
Name of the application
Name of the document
Restore button



Scroll bars

Displayed at the right and bottom edges of the document window.    The scroll boxes inside the 
scroll bars indicate your vertical and horizontal location in the document.    You can use the 
mouse to scroll to other parts of the document.



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the 
arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer to

the border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or dialog 
box with the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Keys: CTRL+F7



Minimize command (application Control menu)

Use this command to reduce the PeepNet window to an icon in the systray.

Shortcut

Mouse: Click the minimize icon  on the title bar.
Keys: ALT+F9



Go get it!

This option sends a GET command to the server requesting the same page as the sniffed host. 
First the necessary cookies (if any) are recreated exactly as on the sniffed host. Some paid sites 
can be accessed this way, but not sites like Hotmail, which track the user’s IP address.
When multiple GET statements are detected (usually for images), a list box will appear, giving 
you the option to select one item to retrieve from Internet.



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.
Keys: CTRL+F10 enlarges a document window.



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Note:    If you have multiple windows open for a single document, the Close command on the 
document Control menu closes only one window at a time.    You can close all windows at once 
with the Close command on the File menu.

Shortcuts
Keys: CTRL+F4 closes a document window

ALT+F4 closes the <<YourType>> window or dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the 
Maximize or Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to or 
close an application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the 
following options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option does 
not affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not affect 
applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.

<< If you wish to author help specific to each message box prompt, then remove the 
AFX_HIDP_xxx values from the [ALIAS] section of your .HPJ file, and author a topic for each 
AFX_HIDP_xxx value.    For example, AFX_HIDP_INVALID_FILENAME is the help topic for
the Invalid Filename message box. >>



IP address of the client. Here will appear hosts from your network segment.



IP address of the server. When possible DNS name will be displayed (only for HTTP sessions).



Type of the session. (SMTP, HTTP, POP, etc).



In this panel will be displayed the server response.



In this panel will be displayed what the client sent to the server.



Number of lines from the message that will be copied to the log file. For emails, 9 lines usually 
will result in logging only the email header and not the email content.



Log the entire message content.



Name of the capture file created by CaptureNet. When CaptureNet runs on the same computer, 
this name will be automatically be set at the program start. This file will be monitored and as 
soon as CaptureNet write it on the disk, PeepNet will load it. 



Launch Notepad to see the log file content.



Select the capture file



When a new captured file is loaded, the sessions left panel will be scrolled to insure the visibility
of the last connection.



Checking this check box will create a .lnk file in the Windows StartUp folder and PeepNet will 
start automatically with Windows. Clearing it will delete the .lnk file.
Works only under Windows 95/98.



Only connections addressed to ports in this list will be displayed.



Write here a custom port value



Insert the custom port value in the filtered port list



Remove the selected ports



Clears the port list (deletes all ports)
No port means ALL PORTS.



Some known ports. Double click a port value to insert it in the left list.



IP addresses oh hosts to be monitored or excluded from monitoring (depending on the Type of 
action)



Write here the IP address and press Insert button



Removes the selected IP addresses



Removes all IP addresses from the list



Use a list of individual IP addresses (unchecked) or a range of addresses (checked)



The first IP address in range



The last IP address in range



Inclusive means hosts with IP addresses in list or range WILL BE monitored



Exclusive means that hosts with IP addresses in list or range WILL NOT BE monitored.



When checked, this IP address filter will be applied.



Pick the log file from disk.



Use HTTP mapping

When running with a proxy, HTTP sessions could be on other ports than 80 (often on port 8000).
In this case, clicking the Go get it button will result in a “Not a HTTP session” error.
To fix this, check this check box and insert 8000 in the port value edit box. 



HTTP mapping value

Insert here the port HTTP is using on your system. Default value is 8000.



Registering SpyNet
Benefits of registration

1. Unlimited support by email.
2. My very warm thanks.

Pricing
Description Price

SpyNet (CaptureNet + PeepNet) $79

Registering information:

Credit card
If you wish to pay by credit card use the following link       
http://www.all-connect.com/ShareRegister/shr2/SpyNet.htm

Western Union
The easiest way I found so far is like this:
1. Bring money to any Western Union agent in your country (they are present in 156 countries) 
and fill out a short form for sending money to:

Name: Nicula Laurentiu Gabriel
Address: Bd. Iuliu Maniu, No.14, Bl.13, Sc.C, Et.5, Ap.106
City: Bucharest
Country: Romania

2. Pay a service fee (around 9%). 
3. Get a receipt with a Money Transfer Control Number (MTCN);
4. Inform me about this transfer. You MUST put in this email the following information:

1. MTCN given by Western Union.

2. Your complete name which you used in the Western Union form (very important!!!).
3. A Company name and/or a person name to whom you want the program to be registered;

As soon as I receive your email, I'll respond with an email with a serial number that can be 
entered (by using copy and paste mechanism) in corresponding fields from Register dialog.
Some Western Union agents phones around the world:

Australia 1 800 501 500 Ireland 1 800 395 395
Austria (0222) 8920380 Israel 1 800 213141



Belgium 0800 99090 Italy 167 220055
Canada 800 235 0000 Netherlands 0800 0566
Czech Republic (02) 24009173 New Zeeland (09) 270 0050
Denmark 800 10711 Russia (095) 1198266
Germany (0681) 9333328 Sweden 020 741742
Greece (01) 927 1010 Switzerland 0512 223358
Hungary (01) 267 4282 United Kingdom 0800 8333 833
Iceland 552 3752 Unites States 800 325 6000
India (011) 331 1122

Postal Mail
Wrap money in some nontransparent paper and send them using postal mail or DHL to:

Name: Nicula Laurentiu Gabriel
Address: Bd. Iuliu Maniu, No.14, Bl.13, Sc.C, Et.5, Ap.106
City: Bucharest
Country: Romania





Print command (File menu)

Use this command to print a document.      This command presents a Print dialog box, where 
you may specify the range of pages to be printed, the number of copies, the destination 
printer, and other printer setup options.

Shortcuts

Toolbar:
Keys: CTRL+P



Print dialog box

The following options allow you to specify how the document should be printed:
Printer

This is the active printer and printer connection.    Choose the Setup option to change the
printer and printer connection.

Setup
Displays a Print Setup dialog box, so    you can select a printer and printer connection.

Print Range
Specify the pages you want to print:
All Prints the entire document.
Selectio
n

Prints the currently selected text.

Pages Prints the range of pages you specify in the From and To boxes.
Copies

Specify the number of copies you want to print for the above page range.
Collate Copies

Prints copies in page number order, instead of separated multiple copies of each page.
Print Quality

Select the quality of the printing.    Generally, lower quality printing takes less time to 
produce.



Print Progress Dialog

The Printing dialog box is shown during the time that <<YourApp>> is sending output to the
printer.    The page number indicates the progress of the printing.

To abort printing, choose Cancel.



Print Preview command (File menu)

Use this command to display the active document as it would appear when printed.    When 
you choose this command, the main window will be replaced with a print preview window in 
which one or two pages will be displayed in their printed format.    The print preview toolbar 
offers you options to view either one or two pages at a time; move back and forth through 
the document; zoom in and out of pages; and initiate a print job.



Print Preview toolbar

The print preview toolbar offers you the following options:
Print

Bring up the print dialog box, to start a print job.
Next Page

Preview the next printed page.
Prev Page

Preview the previous printed page.
One Page / Two Page

Preview one or two printed pages at a time.
Zoom In

Take a closer look at the printed page.
Zoom Out

Take a larger look at the printed page.
Close

Return from print preview to the editing window.



Print Setup command (File menu)

Use this command to select a printer and a printer connection.    This command presents a 
Print Setup dialog box, where you specify the printer and its connection.



Print Setup dialog box

The following options allow you to select the destination printer and its connection.
Printer

Select the printer you want to use.    Choose the Default Printer; or choose the Specific 
Printer option and select one of the current installed printers shown in the box.    You 
install printers and configure ports using the Windows Control Panel. 

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the document is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to 
the type of printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.



Page Setup command (File menu)

<< Write application-specific help here. >>




